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I can…
TI-Nspire™ Handheld (HH) 

Data Collection (DC)
TI-Nspire™ Navigator™ (Nav)

Download an activity from the Science Nspired website. Nav

Analyze kinetic and potential energy relationships using the 
Energy Skate Park simulation.

Nav/HH

Design a roto-copter and use a motion detector to determine its 
terminal velocity.

HH

Make modifications to a design and use TI-NspireTM to analyze 
its effectiveness.

HH

Collect data on the instructor computer and send it out to the 
class for analysis.

Nav/HH/DC

Use a TI-Nspire™ Lab Cradle with more than one sensor. DC

Use and zero a force sensor. DC

Use and zero an accelerometer. DC

Create a document using the TI-Nspire™ CX Navigator™ 
Teacher Software. 

Nav
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Open the TI-Nspire document energy-skate-park.tns.

In this simulation, you will observe the changing potential and kinetic 
energies of a skateboarder-celestial body system as she moves over 
a track with negligible friction. You will also explore the relationship 
between the system’s potential and kinetic energy, and how they 
affect the total energy of the system. Finally, you will explore the 
impact of friction on these potential and kinetic energies.

Read the information on page 1.1.

Move to page 1.2. 
To start the simulation, select and drag the skateboarder up to the top left side of the track. Then, release 
him. You will see the skateboarder moving up and down along the skateboarding track on Earth. The 
skater’s motion follows a predictable path:

1. The skater starts from a stationary position.
2. The skater’s direction of motion changes. 
3. The downward motion of the skater momentarily becomes horizontal at the bottom of the skating 

ramp, and then changes direction in an upward direction.
4. The skater nears the top of the skating ramp on the other side, momentarily stops, then changes 

direction and starts moving again.
5. The downward motion of the skater momentarily becomes horizontal at the bottom of the skating 

ramp, and then changes direction in an upward direction.
6. The skater reaches the top of the skating ramp where he originally started, momentarily stops, 

then it resumes a new cycle of movement.

Part 1: Exploring Potential Energy
1. Wait until the skateboarder reaches the top part of the ramp and 

select the Pause button . Your screen should now look like this. 
In this position the skateboarder isn’t moving, but that doesn’t 
mean the skateboarder doesn’t have any energy. In fact, the 
skateboarder-celestial body system has potential energy (PE). 

Potential energy (PE) is based on the mass (m) of the 
skateboarder, the height (h) above the bottom of the ramp, and 
the acceleration due to gravity (g) for the celestial body he is on. 
The potential energy equation is PE = m•g•h. 
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2. Select the Play button so the skateboarder starts moving. As 
the skateboarder moves, her potential energy is converted to 
kinetic energy (KE), or the energy of motion as her position 
changes along the track and the velocity changes. The maximum 
amount of kinetic energy the skateboarder can have is entirely 
dependent on the amount of potential energy of the system. 
You saw in the equation for the PE that there are three variables, 
mass (m), height (h), and acceleration due to gravity (g). In this 
simulation you can modify h and g.
Grab and drag the bottom green point of the skating ramp and 
shorten its height to decrease the magnitude of h.  

Q1. How does shortening the height of the ramp change the potential energy of the system? How does 
the decreased height affect its kinetic energy? What happens when h = 0? 

3. Restore the original skating ramp by selecting the Undo button 
. Then start the simulation by dragging and dropping the 

skater at the top of the ramp. Now vary the acceleration due to 
gravity by changing celestial bodies for the system to see the 
effect on the potential energy. Select the Gravity button once 
to change the force of gravity from the Earth to the Moon. The 
Moon has one-sixth the force of gravity of Earth, so the value of g
will be different than that of the Earth.  

Q2. What happened to the skateboarder’s motion when you switched from the Earth to the Moon? 
What does this tell you about the potential energy that skater has in the skater-Moon system?
Compare the acceleration due to gravity gE on Earth and gM on the Moon.

4. Restore the original skater to Earth and restart the simulation. 
Quickly select the Gravity button twice to change the scene 
from Earth to Jupiter. Jupiter’s force of gravity is 2.5 times that of 
Earth.  

Q3. What happened to the skateboarder’s motion when you switched from the Earth to Jupiter? What 
does this tell you about the potential energy that skater has in the skater-Jupiter system? Compare 
the acceleration due to gravity gE on Earth and gJ on Jupiter.
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Part 2: Exploring Kinetic Energy
5. Reset the simulation so that the ramp is in the standard shape 

and the acceleration due to gravity is for Earth. Start the 
simulation to observe the motion of the skateboarder. 

The Kinetic Energy (KE) of the skateboarder is based on two variables, the skateboarder’s mass 
and her velocity (v). The mass of the skateboarder doesn’t change, but the speed does. This means 
that the KE changes, too.

6. This graph shows the changing KE for the skateboarder. At the 
top of the ramp, before he starts moving downward, the 
skateboarder has zero KE, due entirely to the fact that he is not 
moving. At the bottom of the ramp, the skateboarder has 
maximum KE because he is moving at the fastest speed.

Q4. At the top of the ramp, where the skateboarder has zero KE, what is the potential energy of the 
system?

Q5. At the bottom of the ramp, where the skateboarder has maximum KE, what is the potential energy 
of the system?

Q6. At what part of the skateboarder’s motion is KE converted back to PE?

7. Now change the setting from the Earth to the Moon and then to 
Jupiter. Note the changes to the speed in going from Earth to 
Moon and Earth to Jupiter.
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Q7. In which system is the maximum KE the greatest, the Earth, the Moon, or Jupiter?

Q8. In which system is the maximum KE the least, the Earth, the Moon, or Jupiter?

Part 3: Exploring the Total Energy
8. You’ve seen how the potential and kinetic energies of the 

systems change for the skateboarder. The two main areas you’ve 
explored are the places where the potential energy is at a 
maximum and the kinetic energy is at a minimum, or the potential 
energy is at a minimum and the kinetic energy is at a maximum. 
But between these extremes are the places along the ramp 
where the Total Energy (TE) of the system is equal to the sum of 
the potential and kinetic energies.

TE = PE + KE  

9. This graph shows the changing values for the potential energy 
(solid line) and the kinetic energy (dashed line) of the system. 
You can use this graph to find the Total Energy (TE) at any point 
on the ramp.

Q9. Identify several different Position points and find the values of the corresponding Energy 
coordinates for both PE and KE. Use a ruler to measure the height of each Energy value. Add the 
two values for PE and KE to find TE. What do you notice about the TE for any positions along the 
curve?

10. The law of conservation of energy states that the total energy in a system is constant. At any point 
along the track, the skateboarder has varying values for PE and KE, but at all points along the ramp 
the sum of PE and KE is constant.

Q10. Suppose that energy conservation didn’t occur. Describe how this could affect the motion of the 
skateboarder.
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Part 4: Exploring the Impact of Friction
11. Restart the simulation with the standard ramp and acceleration of 

gravity for the Earth. You’ll notice that the motion of the 
skateboarder goes back and forth continuously and would 
continue this way indefinitely. In reality, you know that a skater 
would eventually come to a stop because of the force of friction
between the skateboard and the ramp. Friction is a damping
force that, in effect, slows things down.

12. Select the slider that controls friction. It is in the bottom center of 
the screen. Drag the slider slowly to the right.

Q11. What happens to the motion of the skateboarder as the friction increases?

13. As the skateboarder goes down the ramp, potential energy is converted to kinetic energy. Because 
of friction, some of the energy in the system is converted to heat energy. Once the kinetic energy is 
converted to heat, the energy cannot be converted back to the potential or kinetic energy in the 
system. 

Q12. Once the skateboarder comes to a stop due to friction, describe the energy needed to have the 
skateboarder resume moving up and down on the ramp.
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Science Objectives
Students will describe the variables that affect potential energy 
and kinetic energy
Students will explore the conversion of potential energy to kinetic 
energy
Students will describe the total energy as the sum of potential 
energy and kinetic energy
Students will explore the effect of friction on kinetic energy and 
potential energy

Vocabulary
• potential energy (PE) • kinetic energy (KE)

• total energy (TE) • mass

• velocity • friction

• gravitational force • acceleration due to gravity   

About the Lesson
This lesson involves students simulating the motion of a 
skateboarder on a ramp under a number of different conditions 
that affect the potential and kinetic energies of the skateboarder-
celestial body system.
As a result, students will:

Describe the variables used to calculate potential energy;
Describe the variables used to calculate kinetic energy;
Explore conservation of energy;
Explore how potential energy, kinetic energy, and the energy 
from friction account for the total energy of the skateboarder.

TI-Nspire™ Navigator™
Send out the energy-skatepark.tns file.
Monitor student progress using Class Capture.
Use Live Presenter to allow students to show how they 
manipulate variables that effect results.

Activity Materials

Compatible TI Technologies:  TI-Nspire™ CX Handhelds, 

TI-Nspire™ Apps for iPad®, TI-Nspire™ Software

Tech Tips:
This activity includes screen
captures taken from the TI-
Nspire CX handheld. It is 
also appropriate for use with 
the TI-Nspire family of 
products including TI-Nspire 
software and TI-Nspire App. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld.
Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.  

 Access free tutorials at
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials

Lesson Files:
Student Activity

Energy_Skate_Park_Student
_HS.doc
Energy_Skate_Park_Student
_HS.pdf

TI-Nspire document
 energy-skate-park.tns
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Discussion Points and Possible Answers
Allow students to read the information on page 1.1.

Move to page 1.2.
Part 1: Exploring Potential Energy
In this part of the lesson students explore the skateboarder’s potential 
energy as he moves up and down the ramp. They investigate how 
potential energy is converted to kinetic energy.

Tech Tip: Make sure students are familiar with the different 

buttons of the simulation. They can:

select to change the track shape

select the Gravity button to change the force of gravity

select to reset the skateboarder, press to stop the motion of the 
skateboarder, press to start the motion of the skateboarder

select to reset the skateboarder, track, and gravity

 grab and drag the slider next to “Friction” to change 

the amount of friction between the skateboard and the track

grab and drag to change the shape of the track

1. Start the simulation with the skateboarder at the top of the ramp. Make sure the skateboarder is 
stationary. Reinforce that the skateboarder, even while stationary, has energy. Potential energy is 
based on position.
As the skateboarder moves along the ramp focus on how the potential energy changes, since the    
height (h) along the ramp changes. The change in potential energy affects the skateboarder’s 
motion, turning the potential energy into kinetic energy.

2. To more fully explore the potential energy’s dependence on the 
variable h, have the students vary the depth of the skateboarding 
ramp. Having them change the ramp to a flat line brings the 
skateboarder to a stop. Because potential energy is based on the 
value of h, in a situation in which h is zero, then the skateboarder 
has no potential energy when the ramp is flat. With less potential 
energy, there is less kinetic energy available, which affects the 
skateboarder’s motion.
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Q1. How does shortening the height of the ramp change the potential energy of the system? How does 
the decreased height affect its kinetic energy? What happens when h = 0? 

Answer: Decreasing the value of h decreases the potential energy of the system. With less 
potential energy, there is less kinetic energy available to the skateboarder. When h = 0, there is no 
potential energy.

3. To more fully explore the potential energy’s dependence on the 
variable g, have the students change the location of the ramp 
from Earth to the Moon and from Earth to Jupiter using the 
Gravity button . The Moon’s gravity is less than Earth’s, and 

Jupiter’s gravity is greater than Earth’s. Changing the value of g
changes the potential energy and therefore the available kinetic 
energy. 

Q2. What happened to the skateboarder’s motion when you switched from the Earth to the Moon? 
What does this tell you about the potential energy that skater has in the skater-Moon system?
Compare the acceleration due to gravity gE on Earth and gM on the Moon.

Answer: The skateboarder slowed down. This means the amount of potential energy available on 
the Moon is less because gM < gE . 

4. Help students see that once they quickly change to Jupiter, the skateboarder’s speed increases.

Q3. What happened to the skateboarder’s motion when you switched from the Earth to Jupiter? What 
does this tell you about the potential energy that skater has in the skater-Jupiter system? Compare 
the acceleration due to gravity gE on Earth and gJ on Jupiter.

Answer: The skateboarder went faster. This means the amount of potential energy available on 
Jupiter is more because gJ > gE . 

TI-Nspire Navigator Opportunities 
Allow students to volunteer to be the Live Presenter and demonstrate how to adjust the parameters of 
height, gravity, and friction.
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Part 2: Exploring Kinetic Energy
In this part of the lesson students explore the skateboarder’s kinetic 
energy as she moves up and down the ramp. They investigate how 
kinetic energy is converted to potential energy.

5. Reinforce that the KE for the skateboarder varies throughout the 
trip back and forth along the ramp. In fact, the KE cycles through 
values ranging from zero to a maximum and back to zero. Also, 
because the amount of KE is dependent on the amount of PE, 
changing gravitational acceleration from the Earth to the Moon 
and to Jupiter has a marked effect on the skateboarder’s speed.

6. Ensure students understand the variables shown in the diagram and discuss various points along the 
curve.

Q4. At the top of the ramp, where the skateboarder has zero KE, what is the potential energy of the 
system?

Answer: The skateboarder has maximum PE.

Q5. At the bottom of the ramp, where the skateboarder has maximum KE, what is the potential energy 
of the system?

Answer: The skateboarder has zero PE.

Q6. At what part of the skateboarder’s motion is KE converted back to PE?

Answer: As the skateboarder is moving from the bottom of the ramp to the top, the KE is 
converted to PE, as the skateboarder begins to slow down and come to a momentary stop at the 
top of the ramp.

Q7. In which system is the maximum KE the greatest, the Earth, the Moon, or Jupiter?

Answer: Because Jupiter has the greatest acceleration due to gravity, g, then the skateboarder 
has the greatest KE on this planet.
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Q8. In which system is the maximum KE the least, the Earth, the Moon, or Jupiter?

Answer: Because the Moon has the least acceleration due to gravity, g, then the skateboarder 
has the least KE on the Moon.

Part 3: Exploring the Total Energy

8. In this part of the lesson students explore the total energy of the 
system and that this encompasses the sum of the KE and PE. In 
fact, because of the law of conservation of energy, the sum of KE 
and PE is constant throughout the skateboarders trek along the 
ramp.

9. Have students take a number of measurements of the values of 
KE and PE using a ruler. Have students add these 
measurements. Gather data for different measurements and 
among different groups of students. Show that the values are 
consistently close to each other, and barring slight measurement 
errors, the sums of PE and KE are constant.

Q9. Identify several different Position points and find the values of the corresponding Energy 
coordinates for both PE and KE. Use a ruler to measure the height of each Energy value. Add the 
two values for PE and KE to find TE. What do you notice about the TE for any positions along the 
curve?

Answer: The sum of PE and KE are about the same for different positions along the ramp.

10. Discuss the included diagram and have students explain the relationship between PE, KE and 
skateboarder’s location on the ramp.

Q10. Suppose that energy conservation didn’t occur. Describe how this could affect the motion of the 
skateboarder.

Answer: If the skateboarder’s total energy was not constant, then the motion of the skateboarder 
would be unpredictable, and not the steady back and forth shown in the simulation.
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Part 4: Exploring the Impact of Friction
11. In this part of the lesson students see the effect of friction on the 

skateboarder’s motion. While the total energy of the system is 
constant, the energy from friction cannot be converted back to KE 
or PE.

12. In the frictionless scenario, students saw that PE is converted to 
KE and KE is converted to PE, as the motion of the skateboarder 
is like a pendulum swinging back forth. Friction changes this 
scenario. PE is converted to KE and some of the KE is converted 
to heat energy due to friction. This heat energy is lost to the 
system and cannot be converted to PE or KE. Eventually, the 
skateboarder comes to a stop. But even in this scenario, the total 
energy is conserved.

Q11. What happens to the motion of the skateboarder as the friction increases?

Answer: Eventually, the skateboarder comes to a stop.

13. Discuss the included diagram and have students explain the relationship between PE, KE and 
skateboarder’s location on the ramp.

Q12. Once the skateboarder comes to a stop due to friction, describe the energy needed to have the 
skateboarder resume moving up and down on the ramp.

Answer: Once the skateboarder stops, she is at the bottom of the ramp. To get her moving again, 
a new source of KE is needed to move the skateboarder back to the top of the ramp, where she 
will once again have maximum PE.

TI-Nspire Navigator Opportunities 
Allow students to volunteer to be the Live Presenter and demonstrate how to adjust the parameters of 
height, celestial body, and friction. Use Quick Poll to check for understanding during the course of the 
activity.
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Wrap Up
When students are finished with activity, collect students’ worksheets.

Assessment
Formative assessment will consist of questions embedded in the student worksheet. Analyze 
questions in the student worksheet with the students. 
Summative assessment will consist of questions/problems on the chapter test.
In groups, have students construct another example of where PE is converted to KE and 
back. Some examples could include a ball rolling off a table and bouncing, bungee jumping, 
or a yo-yo. 
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Activity Overview
In this activity, you will explore the motion of a roto-copter using a 
CBR 2™ motion sensor. After determining the terminal velocity from a
position-versus-time graph, you will explore how the design of the 
roto-copter can be reengineered to minimize its terminal velocity.

Materials 
CBR 2™ motion sensor Scissors
Paper clips Tape

. 

1. Use the roto-copter template to cut out the roto-copter 
and attach the paperclip. Drop the roto-copter and 
watch its motion. Make a sketch of the roto-copter 
along with the forces acting on the roto-copter as it falls.

Individually, predict the graph of position versus time if 
the roto-copter is dropped over a CBR 2. Make a sketch 
and compare it with the graphs of your partners.

Prediction of the 
position graph

Draw the forces acting 
on the roto-copter

2. Connect the CBR 2 to the TI-Nspire™ handheld and place it on the floor. Collect data as you 
drop the roto-copter toward the CBR2. How does the graph compare with your prediction? 
What does the shape of the position graph indicate about the motion of the roto-copter?

3. The roto-copter reaches terminal velocity quickly. Use the position-versus-time graph to determine 
the terminal velocity of the roto-copter. Select the region of the graph where the roto-copter has a 
constant velocity by clicking on the left side of the region and dragging the cursor with double 
arrows across to the right edge of the region you want to analyze. Select Menu > Data > Strike 
Data > Outside Selected Region. The remaining section shows the constant terminal velocity.

4. From the Analyze Menu, find the equation of the linear data using the Model feature. To use the 
model feature, choose the default mx+b and enter values for m and b that make sense for your 
data. These values can be adjusted using the arrows on the left side of the screen or by clicking on 
the number value and typing a new value. Record the equation that best fits the data. 

___________________________

You may want to also calculate the linear regression for the data using the Analyze menu and 
selecting Curve Fit rather than Model. Compare this equation with the model that you developed.  
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5. How can you use the equation to determine the terminal velocity of the roto-copter? 
Explain your reasoning clearly. Record your terminal velocity.

6. What factors affect how the roto-copter falls? Make a list.

7. Team Competition: Work with your team to design a roto-copter with the lowest terminal velocity. 
Write a paragraph to explain the reasoning for modifications that you make.  Include a sketch.

8. Each team will now drop their roto-copter and calculate the new terminal velocity. Make a 
presentation to show your terminal velocity and evidence of the terminal velocity. The team with 
the lowest terminal velocity wins the competition.

9. State Newton’s 1st and 2nd Laws of Motion and describe how they apply in this activity.
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A B

C D

The template for the roto-copter is shown to the right. 

1. Cut along the solid lines and fold along the dotted lines.  

2. Fold parts C and D over each other to overlap.

3. Fold the bottom up and put a paperclip on it to hold the 
roto-copter together.

4. Hold the roto-copter from the paperclip when you drop it 
over the CBR 2. 
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Science and Engineering Objectives 
Students will use a roto-copter with a CBR 2™ motion sensor to 
calculate terminal velocity
Students will analyze the forces on the roto-copter and apply 
Newton’s Laws of Motion
Students will calculate the slope of a position-versus-time graph 
to calculate the terminal velocity of the roto-copter.
Students will modify their original roto-copter to decrease the 
terminal velocity.

Vocabulary
 velocity

terminal velocity
net force

About the Lesson
This lesson has students create a roto-copter from a template 
and calculate its terminal velocity.  
Students will apply Newton’s 1st and 2nd Laws of Motion.
Once the students calculate the terminal velocity for the roto-
copter, they will engineer their own roto-copter, making 
adjustments to the template. They can make changes to length, 
mass, width of wings, etc with the goal being to have the smallest 
terminal velocity. Students will compete with other students/teams 
to engineer a roto-copter with the smallest terminal velocity as 
measured with the CBR 2™. 

TI-Nspire™ Navigator™ System
Use the TI-Nspire Navigator System to show student graphs and
find the slope of the position-versus-time graph to calculate the 
terminal velocity.
Students can display their graphs and calculations in the 
competition using the TI-Nspire Navigator System.

Activity Materials
CBR 2™ motion sensor Tape

    Paper clips Various types of paper
   Scissors Prizes for winners if desired

TI-Nspire™ Technology Skills:
Use the Vernier 
DataQuest™ Application
Collect data for position and 
time with a CBR 2™ 
Calculate the velocity of a 
position versus time graph 
by modeling and by linear 
regression.

Tech Tips: 
Change the default screen 
with two graphs to only one 
graph of position versus 
time.

Lesson Files: 
Student Activity

Roto-copter_Student.pdf
Roto-copter_Student.doc

3-23



Roto-copter TEACHER NOTES

TI PROFESSIONAL DEVELOPMENT

©2014 Texas Instruments Incorporated 2 education.ti.com

Discussion Points and Possible Answers

1. Use the roto-copter template to cut out the roto-copter and attach 
the paperclip.  Drop the roto-copter and watch its motion. Make a 
sketch of the roto-copter along with the forces acting on the roto-
copter as it falls.   Individually, predict the graph of position versus 
time if the roto-copter is dropped over a CBR2TM. Make a sketch 
and compare it with the graphs of your partners.

Answer: Sketches of predictions will vary and should not be 
marked as incorrect. Since the roto-copter is approaching the 
CBR 2, the graph should be linear with a negative slope like 
the graph shown to the right. 

       The free body diagram of the forces is shown to the right. FR 
is the resistive force due to air resistance and can be labeled 
with a variety of names but should be directed upward. Mg is 
the weight of the roto-copter and must be directed downward.  

2. Connect the CBR 2 to the TI-Nspire™ handheld and place it on 
the floor. Collect data as you drop the roto-copter over the CBR 2.  
How does the graph compare with your prediction?  What does 
the shape of the position graph indicate about the motion of the 
roto-copter?

Answer: See the sample graph to the right.

Tech Tip: Students might need to try a few times to get a good data set 
and might see a spike where the motion detector missed the roto-copter 
due to the spinning. Decreasing the time to 1 or 2 seconds should help 
students to see the section of constant velocity a little easier.

Tech Tip: Using the Model feature for analysis allows student to enter 
values that make sense with the data. This forces students to analyze the 
data and find an equation rather than just run a regression. The Model 
feature also allows a student to overlook a spike and discount it, which the 
regression feature will not do. The regression can be used after the model
is found to compare.

FR

Mg
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3. The roto-copter reaches terminal velocity quickly. Use the 
position-versus-time graph to determine the terminal velocity of 
the roto-copter. Select the region of the graph where the roto-
copter has a constant velocity by clicking on the left side of the 
region and dragging the cursor with double arrows across to 
the right edge of the region you want to analyze. Press 
Menu 2:Data 5: Strike Data 2: Outside Selected Region. 
The remaining section shows the constant terminal velocity.  

Answer: The student should select the data as shown above 
and then strike the data to obtain a graph like the one shown 
to the right. Students may keep both graphs on the screen or 
change to show graph 1 only.

4. From the Analyze menu, find the equation of the linear data 
using the Model feature. To use the Model feature, choose the 
default mx+b and enter values for m and b that make sense for 
your data. These values can be adjusted using the arrows on the 
left side of the screen or by clicking on the number value and 
typing a new value. Record the equation that best fits the data. 

Answer: The equation for the sample data is y = -1.45x +2.05
from the model.  

You may want to also calculate the linear regression for the 
data using the Analyze menu and selecting Curve Fit rather 
than Model.  Compare this equation with the model that you 
developed. 

Answer: The regression equation for the sample data is 
displayed to the right.  Arrow down to see the regression values.

5. How can you use the equation to determine the terminal velocity of the roto-copter?  
Explain your reasoning clearly. Record your terminal velocity.

Answer: The slope is the terminal velocity. For the sample data, the terminal velocity is -1.4 m/s.  
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6. What factors affect how the roto-copter falls? Make a list.

Answer: The answers will vary, but could include: the mass of the paperclip, the length or 
width of the propellers, the overall mass of the roto-copter, the length of the body, the shape of 
the propellers, etc.

7. Team Competition: Work with your team to design a roto-copter with the lowest terminal velocity. 
Write a paragraph to explain the reasoning for modifications that you make. Include a sketch.

Answer: The answers will vary. They should include a sketch and well written paragraph with 
complete sentences to describe the changes that the group made.

8. Each team will now drop their roto-copter and calculate the new terminal velocity. Make a 
presentation to show your terminal velocity and evidence of the terminal velocity. The team with 
the lowest terminal velocity wins the competition.

9. State Newton’s 1st and 2nd Laws of Motion and describe how they apply in this activity. 

Answer: Newton’s 1st Law states that an object at rest or moving at constant velocity will remain 
at rest or moving at constant velocity unless acted upon by and unbalanced force.  Newton’s 2nd

Law states that the net force acting upon an object produces an acceleration and the force and 
acceleration are directly proportional if the mass is held constant. Often, the 2nd Law is 
summarized with an equation F = ma, F represents the net force acting on the object, m
represents mass, and a represents acceleration. In this activity, the weight or force due to gravity 
is the only force at the start so the object accelerates according to Newton’s 2nd Law. The air 
resistance force increases with velocity and quickly becomes equal to the weight but directed 
upward. The net force now becomes zero and the roto-copter now moves with constant velocity 
as indicated in Newton’s 1st Law.  This constant velocity is referred to as terminal velocity.

TI-Nspire Navigator Opportunity: Students can use the TI-Nspire Navigator System to show 
their data and explain their reasoning.  

Wrap Up
Discussion of how forces affect the roto-copter’s motion and what factors affected a design of a 
roto-copter with a lower terminal velocity.

Assessment
Equations and competition are the assessment in this activity along with the ability to justify from 
evidence.
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Q1:  What two variables were tested and collected by your teacher during the experiment? Make a 
prediction of what the graph would like when you graph those variables together. Determine 
which variable to put on the y-axis and x-axis.

Step 1:

When you receive the document press Open. The document should open with the stored data that 
was collected by your teacher.

Step 2:  

Once you have opened the document, insert a Data & Statistics page by pressing ~ and selecting 
Insert > Data & Statistics. 

Q2:  What do you notice about the data after you enter the Data & Statistics page?

Step 3:

In order to organize the data, hover over the box on the y-axis. It should bring up some options.  
What variable needs to be graphed on the y-axis? Why? 

Step 4:  

Now you need to assign a variable to the x-axis. Repeat the same procedure in Step 3 to do so.  
Which variable did you assign on the x-axis and why?

Activity Overview
This activity will introduce the Dual-Range Force Sensor, an accelerometer, and TI-Nspire™ Lab Cradle 
with the Vernier DataQuest™ application. You will analyze data that has been collected by your teacher. 

Background Information 

Newton’s 2nd Law states that: 

The acceleration of an object as produced by a net force is directly proportional to the magnitude of the 
net force, in the same direction as the net force, and inversely proportional to the mass of the object.
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Q3:  Now that your data is organized, what type of relationship does it represent? How does this 
graph compare to your prediction?

Q4:  Run a regression on your data by selecting Menu > Analyze > Regression.

Write down the regression equation:                            ____________________________________

What does the slope of your line represent?

Q5:  Write a general equation that represents the relationship between force, acceleration and mass.  
Which of Newton’s Laws does this relationship model?

Step 5:  

Obtain the actual mass of the system that was used from your teacher. Record that mass below.    

Actual Mass of System      _______________

Q6:  How does the actual mass of the system compare to the experimental value obtained during the 
experiment?

Q7:   Calculate the relative error by subtracting the Actual mass of System from the experimental mass.

Q8:  Calculate the percent error by taking the Relative Error and dividing by the actual mass of system, 
multiply by 100%. What does the error value tell you about the experiment?  What factors can 
contribute to the error in the experiment?

Discussions/Explorations
Write a summary of what you learned in this activity. Use at least two complete sentences.  
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Math and Science Objectives
Students will graph the relationship between force and 
acceleration. 
Students will run a regression to determine the relationship 
between force and acceleration.

Vocabulary
force relative error
mass percent error
acceleration slope

About the Lesson
This lesson involves the teacher collecting a set of data as the 
Live Presenter and sending it out to students to analyze. 
As a result, students will:

Insert a data and statistics page and graph the data. 

Run a regression. 

Determine the mass of the system. 

Calculate percent error. 

TI-Nspire™ Navigator™ 
Use the TI-Nspire™ Navigator System to send out the data.
Use the Class Capture feature to monitor student progress and 
check for understanding.

Activity Materials

Compatible TI Technologies: TI-Nspire™ CX Handhelds,

TI-Nspire™ Software. 

Dual-Range Force Sensor
 TI-Nspire™ Lab Cradle

Low-g Accelerometer
Electronic scale or balance.

Tech Tips: 
This activity includes screen 
captures from the TI-Nspire 
CX handheld. It is also 
appropriate for use with the 
TI-Nspire family of products 
including TI-Nspire software. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld.
Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.
Access free tutorials at 
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials  
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Introduction
Before you begin the activity, show the class what the sensors look like while taped together. Show 
students how you will conduct the experiment and asks them to make a prediction as instructed on 
their lab sheets. This prediction step is important in helping students to connect the ideas and 
enhance conceptual understanding.

Data Collection
1. Open the TI-Nspire™ CX Navigator™ Teacher Software and 

connect the TI-Nspire™ Lab Cradle to the computer using the 
standard-A to mini-B USB connection cable.  

2. With masking tape, secure the accelerometer to the force probe.  
Make sure the arrow is pointing opposite the hook or downward.  

3. Set the force probe to 10 N.  
4. Measure the mass of the accelerometer and force probe 

together. Do not include the cables. This will cause for a large 
amount of error in the results.

5. Plug both sensors into the TI-Nspire™ Lab Cradle.  The Vernier 
DataQuest™ application should automatically open up and 
detect both sensors.

6. Zero both sensors. Stand them on end with the hook pointing
upward on the force sensor, the accelerometer arrow should be 
pointing down. In order to zero, click on the meter itself and a 
menu should show up. Click zero at the bottom of the page. Do 
this for both sensors.

7. To begin collecting data, click the green Start Collection
arrow in the upper-left corner of the screen, or press Tab until 
the start arrow is highlighted and press Enter. 

8. Holding the hook between your fingers, shake the force probe 
gently for the entire run time.

9. Once you have collected the data, send the data set out to all 
the students using the TI-Nspire™ CX Navigator™ System.  

Tech Tip: Make sure students are logged 
in ahead of time before starting the experiment.  
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Student Questions and Answers

Q1. What two variables were tested and collected by your teacher during the experiment? Make a 
prediction of what the graph would like when you graph those variables together. Determine 
which variable to put on the y-axis and x-axis.

Answer: Student answers will vary because this is a prediction

Q2:  What do you notice about the data after you enter the Data & 
Statistics page?

Answer: Students should notice that there is NO organization 
to the data. They may even notice that theirs looks different 
from their neighbors.

Teacher Tip: Use the Live Presenter feature of the TI-Nspire™
Navigator™ System to show how they all are different

Students will have the discussion about what variable to graph on the x-axis and y-axis. 
You can guide them if you like or let them choose. This opens the discussion for which 
answer is better later in the activity. Essentially, if they graph force on the y-axis and 
acceleration on the x-axis, their results make more sense.

Q3:  Now that your data is organized, what type of relationship 
does it represent? How does this graph compare to your 
prediction?

Answer: Students should notice that the relationship tends 
to be linear when organized.

Q4:  What does the slope of your line represent?

Answer: The slope of the line represents the mass of the system. If they graphed the 
acceleration on the y-axis and force on the x-axis, they will get the inverse of the mass.

Q5:  Write a general equation that represents the relationship between force, acceleration and mass.  
Which of Newton’s Laws does the relationship model?

Answer: F = m a
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Q6:  How does the actual mass of the system compare to the experimental value obtained during the 
experiment?

Answer: They should be comparable.

Q7:   Calculate the relative error by subtracting the Actual mass of System from the experimental mass.

Answer: Answers will vary.

Q8:  Calculate the percent error by taking the Relative Error and dividing by the actual mass of system, 
multiply by 100%. What does the error value tell you about the experiment? What factors can 
contribute to the error in the experiment?

Answer: The percent should be small. Discussion can lead to how hard you shake the device, 
cables getting in the way when measuring the mass of the system, etc…

Discussions/Explorations

Write a summary of what you learned in this activity. Use at least two complete sentences.  

Answer: Answers will vary. It is important to encourage students to explain their thinking using 
complete sentences.  

Wrap Up
You can have students add a model line to see if their results change. If so, this opens up the 
discussion of “why.” Which is better, a regression or model line?
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Science Objectives
Understand graphically the representation of Newton’s 3rd Law. 
Analyze and interpret data (NGSS). 
Engage in argument from evidence (NGSS). 

Vocabulary
force

About the Lesson
This lesson is an interactive lecture demonstration. Students will 
make predictions and discuss them with their group and the 
class. The teacher or a group of students will perform the 
demonstration for the class and students will draw a conclusion.
As a result, students will:

State Newton’s 3rd Law of equal and opposite forces.

Describe the relationship of Newton’s 3rd Law graphically.

TI-Nspire™ Navigator™ 
Use the TI-Nspire™ CX Navigator™ Teacher Software to 
conduct the demonstration.  

Activity Materials

Compatible TI Technologies : TI-Nspire™ CX Handhelds,

TI-Nspire™ Software

2 Dual-Range Force sensors
 TI-Nspire™ Lab Cradle
 String

Tech Tips: 
This activity includes screen 
captures from the TI-Nspire 
CX handheld. It is also 
appropriate for use with the 
TI-Nspire family of products 
including TI-Nspire software. 
Slight variations to these 
directions may be required if 
using other technologies 
besides the handheld.
Watch for additional Tech 
Tips throughout the activity 
for the specific technology 
you are using.
Access free tutorials at 
http://education.ti.com/calcul
ators/pd/US/Online-
Learning/Tutorials  

Lesson Files: 
Student Activity

Newton’s_3rd_Law_Teacher.
pdf
Newton’s_3rd_Law_Teacher.
doc

TI-Nspire document 
Newtons_3rd_Law.tns
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Discussion Points and Possible Answers

Tech Tip: This activity is designed as an interactive lecture 
demonstration and presented through the teacher computer with software.  
The activity can also be done as a student activity. Data can also be
collected from the student handhelds using Live Presenter for the class.

Move to page 1.2

Begin the lesson with a quick poll included in the document.

Answer:  No correct answer should be given yet. This is a
question to get students thinking. They should be able to 
correctly answer the question at the end of the activity.  

1. Set the range switches of the Dual-Range Force Sensors to 50 N. Connect the two 
force sensors to the TI-Nspire™ Lab Cradle.  

2. Zero the forces sensors. Set the sensors horizontally on the 
table with no force acting on them. Select Menu > 
Experiment > Set up Sensors > Zero. You must do this for 
both sensors.
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3. Create a loop of string and use it to connect the two force 
sensors. Pull horizontally on one sensor while holding the 
other sensor. Vary the force as you collect the data for the 
class. You may want to repeat in various ways, having the 
other object pull, etc. See a sample graph to the right.

Teacher Tip: (Optional) Because you will be comparing the 
readings of two different force sensors, it is important that 
they both read force accurately.
To increase the accuracy of the sensors, you may want to 
calibrate them. This is only necessary if the forces do not 
appear equal and opposite when you perform the 
demonstration.  See the Vernier website if you want to learn 
to calibrate a sensor.

4. Ask the class to discuss the resulting graph showing the force on each sensor. 
What does this mean?

Answer: Develop the idea that if one object pulls on an object, the other object exerts 
an equal and opposite force on it. Newton’s 3rd Law states, “If Object A exerts a force 
on Object B, Object B exerts an equal and opposite force on Object A.”

Assessment
Go back and send the Quick Poll from the beginning of the activity to see if students change their 
responses. Discuss the correct answer A.  

TI-Nspire™ Navigator™
This activity uses the TI-Nspire™ Navigator System as a tool to demonstrate an idea and make a 
lecture interactive. This process can also be utilized in classrooms where the teacher may have only 
a few sensors. Data can be collected and sent to the class if desired.  
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About the Activity

You have seen a number of sources for TI-Nspire™ activities. 
To allow you to make the most relevant use of the remainder 
of this workshop, you will have time to explore activities that 
are of particular interest to you for your classroom use. 

Some activities are contained in your workshop binder, some 
are available online through the Teacher Software, or you 
might have found something on your own that you would like 
to explore. You will share your findings with the whole group.

Sources for Activity Materials:  
Workshop binder

 TI-Nspire™ Teacher 
Software content links 

TI-Nspire™ Navigator™ System

If you want, you can use the TI-Nspire™ Navigator™ System to practice enhancing your activity 
presentation, engage your fellow participants, and share any TI-Nspire documents you found 
useful. The T3™ Instructor will be happy to help you with the system.

Discussion Points

Please work through an activity or two in the time provided. While completing the activity, consider:

How does it add new TI-Nspire skills to your repertoire?

What are some pedagogical implications of the activity and its technology use?

What is the content relevance?

How might it engage and motivate your students?

You are encouraged to work in small groups and discuss as you go.

Each group will give a short presentation on an activity and the results of the discussions
surrounding it.

Tech Tip: Try using any TI-Nspire documents on both the TI-Nspire 
Teacher Software and the TI-Nspire handheld. Transfer any documents 
from one to the other and back again.
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